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 The particles within the rock samples are present in extensive ranges of shapes and 
sizes, and their characterization and analysis exist with a considerable diversity. The 
prior research works have appraised the significance of the particle shape types and 
their effects on the geotechnical structures and deficiencies by evaluating the 
uncertainty-related rock particle shape descriptors (PSDs). In this work, the Monte 
Carlo simulation (MCS) is used in order to present a framework to integrate the 
inherent uncertainty associated with PSDs. A tabletop microscope is used to measure 
the primary particle shape distribution for the sandstone samples. An open-source 
processing tool, ImageJ, is used in order to analyze PSDs. The probabilistic 
distribution of PSDs is acquired using MCS according to the relative frequency 
histogram of the input parameters. Additionally, a probabilistic sensitivity analysis is 
performed in order to evaluate the importance of the input parameters in PSDs. The 
sensitivity analysis results demonstrate that the major axis and area are the most 
influential parameters involved. The simulation results obtained have revealed that the 
proposed framework is capable of integrating the inherent uncertainties related to the 
particle shape. 
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1. Introduction 
In the early 20th century, the effects of the micro-

structures on the mechanical behavior of soil have 
been suggested after the development of the 
techniques to represent the form and roundness of 
the particles [1]. In the geotechnical field, various 
researchers have studied the influence of particle 
shape and size on the stability of the geotechnical 
structures such as slopes, dams, and buildings, 
concluding that these micro-structures affect the 
soil properties such as the cohesion, friction angle, 
and shear strength [1-3]. Understanding the 
mechanical behavior of rock mass is the primary 
foci in the slope stability [4] since slope failures 
may lead to the loss of multiple lives and a more 
considerable property damage [5]. The slope 
failure of rocks typically happens as a result of the 
downslope movement of rock mass along the 
failure plane [6]. Understanding the triggering of a 
failure plane in rock mass must be understood [7]. 
Consequently, the effect of the rock micro-

structure on the macroscopic mechanical behavior 
of the rock mass can be significant [8]. Most rocks 
in the nature are composed of irregular mineral 
particles that are strongly bonded together [9]. It is 
believed that the shapes and sizes of the mineral 
particles are crucial to the mechanical behavior of 
the failure surfaces under study. Description of the 
particles present or embedded in the failure surface 
and the asperities is required for a stability 
prediction [10]. Many researchers have tried to 
integrate the particle shape using the discrete 
element method (DEM) using various shape 
descriptors [11]. Nevertheless, naturally, rocks are 
very complex concerning the particle shape [7].  

The literature indicates that the primary emphasis 
on the particle shape and size is in the area of 
geology compared to the geotechnical field [1]. 
The particle shapes can be categorized into 
quantitative and qualitative [1, 12, 13]; quantitative 
describes the measurement of the dimensions, 

mailto:mohd_hazizan@usm.my
http://www.jme.shahroodut.ac.ir


Shah et al Journal of Mining & Environment, Vol. 12, No. 2, 2021 
 

300 

while qualitative measures the shape of the 
particles such as spherical, elongated, and flaky [1, 
13]. The qualitative description of the particle 
shape is based on the measured quantitative 
dimensions [1]. The particle shape has been 
described in three sub-quantities by various 
researchers. These terms describe the shape of the 
particles on a different scale. The terminology is 
the roundness, shape/morphology, and surface 
texture [1]. For classifying the particle shape based 
on morphology/form, the particle volume, 
parameter, axis-length, and surface area are taken 
into consideration [1, 14]. Furthermore, the particle 
corners can be angular or rounded (roundness); 
similarly, they can be rough or smooth (surface 
texture) [1, 14]. According to the historical 
viewpoint, various researchers have used different 
shape descriptors as terminologies such as 
roundness or angularity (sharpness or smoothness 
of the parameters) and sphericity or elongation 
(based on the circle diameter) [14-18]. For the 
particle shape descriptors (PSDs), a common 
terminology is required in order to ensure the 
comparability of the different descriptors but 
unfortunately, there is no common language for the 
researchers to consider and rely on. This significant 
problem can be tackled by using several types of 
shape descriptors simultaneously. It is not feasible 
since the particle size can be represented in 
numerous ways, which result in a number of shape 
descriptors. Consequently, the researchers are 
focusing on the development of new methods in 
order to measure the particle size and shape 
precisely. 

Over the years, the researchers are focusing on 
the introduction of new methods for estimating the 
particle shape [1]. The first method to measure the 
particle form was the hand measurement technique, 
which was replaced by a chart due to being time-
consuming [1, 19-21]. The sieving method has 
been introduced to find the particle elongation and 
flakiness index but this approach is limited to the 
small-size particles [22]. Nowadays, the computer-
based image analysis method is mostly used in 
order to classify the particle shape because it is fast 
and automated [23-25]. Various techniques such as 
the Feret diameter method, Fourier technique, 
fractal dimension method, orthogonal image 
analysis, Laser scanning techniques, and Laser-
aided tomography have been materialized to 
process the images [1]. The image analysis tools 
such as scanning electron microscopy (SEM) scans 
the surface of a rock sample and gives the results 
in 2D [24]. The image-based methods, specifically 
SEM, for particle shape and size, produce images 

having a limited sensing range to the depth of flow, 
which produces uncertainty [1]. The statistical 
analysis method has been suggested by various 
researchers in order to evaluate the uncertainty. 

Nowadays, the researchers have presented the 
probabilistic methods in the geotechnical field 
using the concept of probabilistic modeling in 
order to deal with the inherent uncertainty. 
Generally, the rock profile is very complex; it often 
provides different results than those assumed in the 
analysis and design. These results may be 
attributed to the limited sampling and inherent 
uncertainty related to the particle shape and size 
distribution. There have been numerous 
investigations related to the particle size 
distribution using statistical modeling. Kutchko 
and Kim [26] have used an image analysis 
technique in order to determine the grain size, 
shape, and orientation of the sand and sandstone 
samples. Rahmat and Tajdari [27] has employed 
the digital image processing technique and the 
Kuz-Ram model in order to estimate the rock 
fragments size distribution. Schäfer and Teyssen 
[28] have used the image analysis and statistical 
methodology to find the minimum number of 
particles required for the particle size distribution 
analysis. The author used the Chi-square test in 
order to evaluate the particle shape and size of the 
guava juice powder. Mohamed et al. [29] have 
proposed an extraction algorithm based on the gray 
histogram peak values for the analysis of the 
sediment particle images that could provide 
technical support for the measurement of the 
particle size distribution.  

However, no attempt has been made to evaluate 
the uncertainty-related particle shape distribution 
parameters. Additionally, a previous research work 
was also limited to the incorporation of the 
interdependencies between the uncertain PSD 
parameters and the effect of the distribution type on 
each shape descriptor. In this research work, the 
Monte Carlo simulation-based uncertainty analysis 
framework was developed to model the PSD 
distributions in order to assess the uncertainty in 
the shape descriptor parameters. The suggested 
framework was applied for illustrative purposes in 
a case study of Bukit Merah Laketown, Malaysia. 

2. Materials and methods 

This key section provides an insight into the 
lithologic description of the sample, sample 
preparation, instrument theory, image processing, 
manual particle analysis, and data analysis method.  
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2.1. Sample preparation 
The samples for this analysis were obtained in 

bulk from Bukit Merah Laketown in Malaysia. The 
primary samples were sliced into samples up to 95 
mm in size. In addition, the samples for the trim 
saw were sliced using a Petro cut Geological cutter. 
Following that, using a Petro trim, trim saw, the 
samples were further cut to match the sample stand 
of the tabletop microscope (TTM). The samples 
were coated with a nano-thin coating of conductive 
material to get better images.  

2.2. Instrument factors, image acquisition 

A TTM was used for image acquisition (see 
Figure 1). TTM provides a highly flexible platform 
for the particle analysis. The automated nature of 
the TTM enables it to collect data over multiple 
fields of view.  

For the analysis, the particles were manually 
tracked and saved. Only the particles having 
distinguishable boundaries were traced. The 
operators chose images with a suitable distinction 
between the particles and the background, and 
there was an issue found during the automated 
thresholding and with brightness and contrast.  

2.2.1. Manual analysis 
The particle shape and size were analyzed from 

the sample using a manual particle primary 

method. The particle images with clear and visible 
borders were reported. ImageJ, an open 
architecture software, was used to analyze and 
process the photos that had been reported. In the 
initial step of using ImageJ, the image file was 
upload into a new window using the File>Open, 
File>Import, and Drag & Drop options, followed 
by the spatial calibrations that involved calibrating 
a single image dimension in pixel against the 
known values. The line “selection tool” was used 
in order to draw a line over a scale bar of a known 
length followed by a “set scale” from the “analyze” 
menu. In our case, in the “set scale” dialog box, the 
“known distance” was entered as 200 µm, 500 µm, 
and 1 mm, and the “Global” checkbox was 
examined to apply the spatial calibration to all the 
open image windows. For the image processing 
algorithms, a binary image (black and white) was 
produced using the “Image>Adjust>Threshold” 
tool in the dialogue box. In the binary images, the 
objects were considered as black, while the 
background was white. In the proper thresholding, 
the images were converted into 8-bit, possessing 82 
gray levels. Proceeding with a proper thresholding 
requires binary images that are produced, and the 
individual particles with distinguishable 
boundaries are manually traced. The particle size 
and shape descriptor measurement is accomplished 
using the “set measurement” dialog box command 
in ImageJ.  

 
Figure 1. TTM micrographs of the sandstone samples with different magnifications (a) the image showing 

weathering; (b, c, and d) show the aggregate scale. 
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2.3. Shape descriptors 
There are several shape and size descriptors in 

the literature; however, this work is mainly focused 
on the roundness, circularity, and aspect ratio. The 
size descriptors are used to calculate the shape 
descriptors. The size descriptors reported are area 
(mm2), perimeter (mm), major and minor axes 
(mm), and minimum and maximum Feret 
diameters (mm). The three shape descriptors 
roundness, circularity, and aspect ratio are 
calculated using Equations 1, 2, and 3. 

2

[Area]Roundness = 4
[Major axis]




 (1) 

[Major Axis]Aspect ratio = 
[Minor Axis]

 (2) 

2

[Area]Circularity = 4
[Perimeter]

   (3) 

The particle analysis is based on the physical size 
of the square units or the sum of the pixels, whether 
the pixel units are considered in the image. The 
thresholding procedure estimates the numbers of 
pixels and set into the minimum and maximum 
area sizes in order to specify the area of interest. 
The image thresholding is employed to calculate 
the particle size and shape automatically. 

2.4. Data analysis 
Using the Microsoft Excel, the SimulAr App, and 

the Kolmogorov-Smirnov, the Chi-square and 
maximum likelihood approach were adopted for 
fitting the distribution of the sampling data. The 
descriptor data could be analyzed using the 
conventional P-value statistics. The Cumulative 
Distribution Function (CDF) was configured for 
each descriptor in order to specify the probability 
of the individual value in the sample parameters. 
The best fit distribution process was employed in 
order to analyze the best-fit reference models 
(normal, long normal, beta, Weibull, etc.) for the 
sample parameters. The Monte Carlo simulation 
(MCS) was used for the random experimentation 
of the sampling data based on the previous fit 
distributions. In this work, the Monte Carlo method 
was intended to model the sampling data. 

2.4.1. Probabilistic evaluation of rock PSDs  
MCS is a stochastic simulation technique used to 

generate the models of possible outcomes based on 
the previous fit distribution of the input parameters 
(see Figure 2). The specific probability 
distributions are used as the input parameters in 
order to generate thousands of random values to 
model the possible outcomes. Microsoft Excel is a 
comprehensive set of analysis tools that 
implements MCS by characterizing the uncertainty 
to generate the possible outcomes. It evaluates the 
various types of probability distributions for the 
input values and chooses the most appropriate 
distribution and generates the statistics. For the 
shape descriptors, all the input parameters exhibit 
randomness. The relative frequency histogram can 
be used in order to depict the inherent uncertainty-
related input parameters that can be acquired 
through micrograph using the ImageJ software. 
When the distributions are acquired for the four 
parameters, the distributions of roundness, aspect 
ratio, and circularity can be calculated according to 
Equations 1, 2, and 3; after that, MCS is used to 
model the probability of the output parameters. The 
input values for PSDs are obtained from a random 
sampling of the followed distributions, and the 
probability distributions of the shape descriptors 
are obtained from MCS. 

2.5. Uncertainty analysis in PSDs 
2.5.1. Probabilistic sensitivity analysis in PSDs 

Various sensitivity analysis methods were 
applied in order to determine the relationship 
between the input and output parameters within the 
model including the factorial design, correlation 
method, differential sensitivity analysis, one-at-a-
time (OAT/OFAT), scatter plot, regression 
analysis, and variance-based method [30]. The 
PSD sensitivity analysis could be performed in 
Microsoft Excel. The sensitivity analysis was 
carried out using the correlation method, and the 
outcomes were presented through the tornado plots 
that compared the relative importance of the 
existing distributions and their influence on the 
modeled distribution. The horizontal bar depicts 
the impact of the input distribution on the modeled 
distribution with the highest-valued input at the top 
of the graph. 
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Figure 2. Schematic diagram of the proposed MCS-based uncertainty integration framework. 

3. Results and analysis 
The primary objective of this work was to 

measures the particle shape distribution for the 
sandstone samples. The principal elements of this 
analysis were the particle shape and size 
measurement using ImageJ, the statistical 
modeling of the shape descriptors of the sampling 
data, the MCS of the size parameters using the 
reference probability distribution and fitting the 
distribution to the simulated data.  Five sandstone 
samples were tested for the particle shape 
distributions. The Chi-square test was used in order 
to determine the distribution of the particle shape 
before and after MCS. 

4. Fitting distribution types to input 
parameters for PSDs 

Figure 3, 4, and 5 show the histograms with a 
model, frequency, and the probability distribution 
of the input perimeters along with their Q-Q plot. 

All the four input parameters including the major 
axis, minor axis, perimeter, and area were best 
fitted with the inverse Gaussian reference model. 
The shape descriptor's values were first calculated 
by the deterministic method. After that, the shape 
descriptor’s best-fitted distribution was evaluated. 
The aspect ratio was best fitted with the largest 
extreme value reference model (see Figure 6 ) and 
its P-value; the most possible and alternative most 
likely distribution are given in Table 1. The 
roundness distribution (see Figure 6) was typical of 
the three shape descriptors best fitted to the 
Weibull distribution, whereas circularity was best 
fitted to the smallest extreme value reference 
model (see Figure 6). The relationship of the 
particle size (Feret diameter) with the aspect ratio, 
roundness, and circularity is given in Figure 6. 
Most particles were between 0 µm and 100 µm in 
size. The statistics of the input parameters and 
deterministic shape descriptors are given in Table 
1.  

 
Figure 3. Left-hand-side: Q-Q plot showing the quantile come from the inverse Gaussian distribution; right-

hand-side: frequency distribution, red color; best-fit distribution. 
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Figure 4. Left-hand-side: frequency distribution, blue color; best-fit distribution; right-hand-side: Q-Q plot 

showing quantile came from inverse Gaussian distribution. 

 
Figure 5. Right-hand-side: Q-Q plot showing quantile come from inverse Gaussian distribution; left-hand-side: 

frequency distribution, red color; best-fit distribution. 

Table 1. Summary of distribution types fitted for input parameters. 

Parameter Fitted distribution P-value Log-
likelihood 

Alternative nearest likely 
distribution 

Log-
likelihood 

Area Inverse Gaussian 0.6564 -1313.53 Lognormal -1318.47 
Perimeter Inverse Gaussian 0.28 -904.594 Birnbaum-Saunders -906.141 

Minor axis Inverse Gaussian 0.43 -678.659 Lognormal -680.97 
Major axis Inverse Gaussian 0.44 -772.773 Birnbaum-Saunders -743.935 

Aspect ratio Largest extreme value 0.51 -74.6628 Inverse Gaussian -79.4359 
Roundness Weibull 0.95 69.0804 Normal 67.506 
Circularity Smallest extreme value 0.989 118.623 Weibull 117.652 
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Figure 6. Fitted distribution for PSDs using the deterministic method; scatter graph-correlation between particle 

size and descriptors. 

Table 2. Summary of statistics of input parameters. 

Descriptors Average 
(um) 

Median 
(um) S.D. Coeff. of 

variation 
Stand. 

skewness 
Stand. 

kurtosis 

Parameters 

Area 3724.73 870 10319.5 277.1% 38.4 179.1 
Perimeter 184.127 123.213 170.795 92.76% 14.2044 31.3 

Minor axis 40.7 26.3 42.8 105.35% 18.8 54.2 
Major axis 62.2 41.8 55.4 89.120% 12.1 21.5 

Deterministic 
shape descriptors 

Aspect ratio 1.646 1.53 0.48 29.013% 7.82 8.78 
Roundness 0.65 0.6535 0.1548 23.82% -0.905 -1.52 
Circularity 0.73 0.74 0.12 16.031% -4.0613 1.999 

 
4.1. Probabilistic analysis of PSDs 

The PSD histogram details were acquired using 
the ImageJ software, and a frequency chart of the 
PSD values is shown in Figure 7.  Understandably, 
the PSD input values are demonstrated as the 
continuous random variables in terms of the 
probability mass functions (PMF). The roundness 
is nearly approaching the normal distribution, and 
the aspect ratio is roughly negatively skewed about 
leftwards with lower values, while angularity is 
approximately positively skewed towards the right. 
The statistical distributions of the PSD parameters 
were acquired using Microsoft Excel and SimulAr 

employing Equations 1, 2, and 3. The input 
parameters were simulated up to 1000 iterations. 
The Kolmogorov-Smirnov Goodness-of-Fit test 
was used in order to evaluate the best fit 
distribution. The frequency distributions of the 
MCS-based PSD values are given in Figure 7.  

The statistics of the simulated PSD values are 
given in Table 3. Traditionally, comparing the 
statistics of the PSD simulated and deterministic 
values show small variations. The average and 
median values are 0.63 and 0.66 from the simulated 
roundness distribution, which is close to 0.65 and 
0.65; the results were obtained using the 
deterministic procedure. The other statistics results 
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also show small significant differences such as 
standard deviation reducing from 0.155 to 0.153, 
coefficient of variation from 23.82% to 23.52%, 
standard skewness from -0.905 to -203.55, and 
standard kurtosis from -1.52 to -10.35. The 
quotient obtained by dividing the standard 
deviation (S.D.) by the mean is called the 
coefficient of variance (COV) and depicts the 
uncertainty. Similarly, the average simulated 
aspect ratio is decreased from 1.65 to 1.62, while 
the median is increased from 1.53 to 1.56. The S.D. 

and COV show small changes from 0.48 to 0.411 
and from 29.013% to 25.3%. Comparably, the S.D. 
and COV values for both the simulated and 
deterministic procedure for circularity provide no 
significant difference between the values. 
Nevertheless, the average decreases from 0.73 to 
0.70, and the median increases from 0.74 to 0.75; 
however, no significant difference were found 
from the statistical data for both the deterministic 
and simulated PSD values.  

Table 3. Summary of statistics of the output parameters. 
PSD Average Median S.D. COV (%) Std. skewness Std. kurtosis 

Roundness 0.63 0.66 0.153 23.5 -203.55 -10.35 
Aspect ratio 1.62 1.56 0.411 25.3 1052.8 160.5 
Circularity 0.701 0.75 0.121 16.7 -1050.62 158.7 

 
MCS for the PSD models gives results with best-

fitted distribution, and their parameters are given in 
Table 4. The simulated PSD parameters show a 
significant resemblance to the deterministic PSD. 
Traditionally, the P-value uses an alternative to 
rejection of the distribution type, and its small 
value means a stronger evidence in favor of the 

alternative distribution. The P-value estimated for 
the simulated PSD models shows a significant 
increase, and the nearest alternate fit distribution is 
also estimated. The result revealed that the MCS-
based PSD distribution was identical to the 
distribution followed by the deterministic method.  

Table 4. Summary of the distribution types fitted for the output parameters. 

PSD Fit distribution Parameters P-value Log-likelihood Alternative nearest 
distribution 

Aspect ratio Largest extreme 
value 

Mode 1.44 0.99 -43782.4 Lognormal Scale 0.32 

Roundness Weibull 
Shape 4.85 

0.99 46398.4 Normal Scale 0.71 

Circularity Smallest extreme 
value 

Mode 0.78 1.0 78134.3 Logistic Scale 0.094 
 

The simulation results unearth that MCS is a 
powerful tool for the deterministic procedure for 
evaluating the PSD statistics. The simulation also 
allows the users to get a comprehensive probability 
distribution and an exceedingly capacious range of 
the PSD values against the deterministic technique. 
MCS can also provide more informative statements 
and detailed analysis. By contrast, the deterministic 
method only provides little analysis information 
along with a huge amount of uncertainty, which 
makes the decisions subjective. Moreover, the 
statistics of the PSD values calculated using MCS 
are more reliable compared to the deterministic 
procedure. The statistics (average, median, 

maximum, minimum, standard deviation, 
coefficient of variation, Std. skewness, and Std. 
kurtosis) of the MCS particle shape descriptors 
were acquired from a large number (1000 in this 
case) of the simulated samples using MCS. 
Contrary to the deterministic analysis, the average 
and median of the PSD values are directly obtained 
from the statistics of the input parameters. The 
most critical aspect of MCS is its inclusion; the 
influence of the PSD standard deviations was taken 
into account. Unfortunately, the deterministic 
analysis ignores this consequence, which may 
relate to a certain discrepancy. 
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Figure 7. Fitted model of MCS-based PSD values and their optimal frequency distribution. 

4.2. Probabilistic sensitivity analysis 
In order to investigate the influence of the input 

variables, a sensitivity analysis was performed 
using MCS of the shape descriptors in the 
Microsoft Excel software. Figure 8 illustrates the 
sensitivity tornado plot for the shape descriptor 
parameters. The findings reveal that the area and 
major axis parameters exhibit the greatest 
influence on the PSD values, whereas the minor 
axis and perimeter have a minor impact. In 
Microsoft excel, the sensitivity analysis for MCS is 
performed simultaneously with varying the input 
parameters in order to evaluate the influence of the 
input variables on the output. However, the rock 
particle shape descriptor’s input parameters 
sensitivity analysis was not performed. Instead, 
most researchers think that all the input parameters 
are similarly significant, which makes it difficult to 
identify determining parameters that affect the 
output. 

Consequently, performing the sensitivity tests on 
the ground parameters during the site analysis stage 
is important. The model form and likelihood 
function for each input parameter as well as their 
effect on the measurement are missing from the 
one-way sensitivity analysis (Si-based). 
Contrastingly, the MCS-based sensitivity analysis 

in Microsoft Excel can simultaneously execute a 
multi-factor sensitivity analysis in order to evaluate 
the influence of the multiple input parameters on 
the output parameters.  

5. Discussion  
The material's property response is a function of 

the interaction between the particles. Therefore, 
appraising the influence of the particle shape on the 
mechanical behavior is crucial in terms of the 
damage response, strength properties, cohesion, 
and angle of internal friction. The discrete element 
method (DEM) and clump particle model are the 
two widely used methods to evaluate the 
mechanical behavior of rock mass. Unfortunately, 
these methods comprise a scarcity of matching the 
simulated particle size and shape distribution to the 
rock particles. In order to simulate a rock in DEM 
and particle flow code (PFC), it is necessary to 
investigate the particle shape distribution in a real-
time. The diversity of the outcomes of the 
geotechnical studies indicates the uncertainty 
associated with the particle shape distribution to 
rock mechanical behavior. In order to address this 
problem, in this research work, we propose an 
approach focused on the use of image processing 
techniques in conjunction with MCS. The 
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conceptual framework is based on studies into the 
morphology of the particles in various materials. 

Many researchers have used the image 
processing techniques to examine the shape and 
size of the particles from various sources including 
the wood dust particles [31], fly ash [32], guava 
juice powder [33], titania powder [26], chlorite–
amphibolite rocks [30], 3D-printed sandstone, and 
tight gas sandstone [34]. MCS is also often used in 
order to produce particles during simulations of 
different materials such as granular materials [35] 
and Brownian motion of the particles [36]. In order 
to obtain the suitable and accurate results, a 
sufficient number of particles must be analyzed 
statistically. During the particle analysis, 
uncertainties related to the particle shape are 
present due to the heterogeneous nature of the 
rocks. The deterministic approach, on the other 
hand, is incapable of dealing with these intrinsic 

inconsistencies. Abreu et al. [37] have used MCS 
in order to incorporate the uncertainty-related Q-
system in a tunnel, while Pearson et al. [38] have 
used it to estimate the Hoek-Brown strength 
parameters for Ankara andesite. As a result, an 
MCS-based framework is the ideal way to address 
the inherent uncertainties.  

In this research work, we mainly focused on the 
three types of shape descriptors including the 
roundness, circularity, and aspect ratio because it 
was infeasible to use a number of shape descriptors 
simultaneously. This is due to the fact that the 
particle shape can be described in a variety of ways. 
The proposed framework is validated through the 
Bukit Merah slope, and the consistency of the 
results obtained from the MCS-based method is 
supported by the same distributions accompanied 
by the simulation results relative to the 
deterministic results. 

 
Figure 8. Sensitivity tornado plot showing the significance of each parameter. 

6. Conclusions 
In this work, the Monte Carlo simulation (MCS)-

based uncertainty analysis framework was 
developed in order to model the particle shape. The 
available sample was analyzed for particle shape 
and size using a tabletop microscope (TTM). 
Furthermore, the statistical protocol was used to 

estimate the uncertainty-related input parameters 
and their influence on the output parameters. The 
case study of Bukit Merah Laketown (Malaysia) 
was selected to execute the proposed framework. 
From the results obtained, it was revealed that the 
MCS-based probabilistic analysis enabled us to 
characterize the variability and uncertainty-related 
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input parameters. MCS was used in order to obtain 
the probabilistic distribution of the particle shape 
descriptors (PSDs) on the basis of the relative 
frequency histogram of the input parameters. 

Furthermore, the uncertainty analysis of the 
probabilistic PSD values evinces that the 
probabilistic sensitivity analysis imparts the 
influence of the input reference model on the PSD 
distribution. The outstanding feature of the 
probabilistic sensitivity analysis is the 
simultaneous multi-factor analysis (MFA) using 
the input distribution variation. The results 
obtained demonstrated two things. First, the 
sensitivity analysis revealed that the major axis and 
area had a significant impact on the PSD values. 
Secondly, the presented framework of the image 
analysis using SEM together with the MCS-based 
uncertainty analysis provided an approach for 
assessing the inherent uncertainty in PSDs.  
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  چکیده:

 قاتیمواجه است. تحق یآنها با تنوع قابل توجه لیو تحل هیو تجز اتیها وجود دارند و خصوصاز اشکال و اندازه یعیوس فیسنگ در ط يهاذرات موجود در نمونه
 يو کمبودها یکیژئوتکن يتارهاآنها بر ساخ راتیانواع شکل ذرات و تأث تی، اهم)PSD( تیشکل ذرات سنگ مربوط به عدم قطع يهاکننده فیتوص یابیبا ارز نیشیپ

استفاده شده  PSDمرتبط با  یذات تیادغام عدم قطع يبرا یبه منظور ارائه چارچوب )MCS(مونت کارلو  يساز هیپژوهش، از شب نیاند. در اکرده یابیموجود را ارز
ابزار پردازش  کی، از PSD یاستفاده شده است. به منظور بررس يزیروم کروسکوپیماسه سنگ از م يهانمونه يشکل ذرات برا هیاول عیتوز يریاندازه گ ياست. برا

. علاوه بر دیآیبدست م يورود يپارامترها یفرکانس نسب ستوگرامیبا توجه به ه MCSبا استفاده از  PSD یاحتمال عیاستفاده شده است. توز ImageJمنبع باز، 
که محور و  دهدینشان م تیحساس لیو تحل هیتجز جی. نتاشودیانجام م PSDدر  يورود يرامترهاپا تیاهم یابیبه منظور ارز یاحتمال تیحساس لیتحل کی ن،یا

مربوط  یتذا يهاتیادغام عدم قطع ییتوانا يشنهادیبه دست آمده نشان داده است که چارچوب پ يساز هیشب جیپارامترها هستند. نتا نیرگذارتریتأث یمنطقه اصل
 به شکل ذرات را دارد.

  .ImageJ، يزیروم کروسکوپی، متیحساس آنالیزماسه سنگ،  کلمات کلیدي:
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